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You are familiar with spread sheet from your previous classes.
you have already prepared mark list and tables using spread sheet.
What have you learned in spread sheets?

33

What we have already learnt
• Spread sheets are the software which helps to calculate quickly and easily.

• Different spreadsheets are used in the Operating system such as Windows and GNU/
Linux.

• Microsoft Excel is the widely used spreadsheet in windows.

• Open Office Calc is the spread sheet used in GNU/Linux.

We have learned the following operations in a spread sheet.

• To open spread sheet.

• To type data in the spread sheet.

• Increasing and decreasing the width of the column or height of the row.

• To select cells or cell ranges.

• Merging of cells.

• Arranging data in cells.

• Inserting new row or column.

• Setting the table in ascending or descending order.

• Inserting charts.

• Making the charts attractive.

Spread Sheet for
Data Consolidation and Analysis

We are now in a critical juncture of our project. We have completed
data collection and now entering into the third phase. That is
consolidation of the collected data.
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As part of our project, we have visited houses and collected data
regarding the availability and usage of water. The data thus available
have to be consolidated in order to know the water consumption in a
house, of a person and that of all the houses from which the sample
was collected. But when we do it as such, it is a tedious process. Instead
the entire process can be made simpler by using the software
Spreadsheet. You learnt about it last year. Now we have to consider
how this software can be used to consolidate and analyse the collected
data.

Consolidation of Data
The collected data about the availability and usage of water to

consolidate the availability and usage of water to a table. An example
of the table which you have to prepare is given below. (fig3.1) This
table is to be prepared in a spreadsheet. We can use Open Office Calc
or Microsoft Excel for the purpose. (fig 3.1) An example of the data
collection table is given below.

Figure 3.1 Data Collection Table - Model (Figures are not real)

Drinking 
& 

Cooking

Dish 
Washing

Cloth 
Washing

Others Total

1 Devarajan G. 4 42000 50 65 65 125 305

2 Sadasivan Pillai T. 5 73000 58 87 92 160 397

3 Rasheed T.H 3 160000 29 52 64 121 266

4 Varghese. X 3 325000 52 77 92 152 373

5 Mohanan Nair 6 32000 67 74 85 174 400

6 Syamala Kumari R. 5 84000 61 71 89 161 382

7 Omana S. 2 99200 20 30 41 82 173

8 Abdul Salam M. 3 243000 31 48 48 81 208

9 Yohannan V. 5 142000 72 109 157 270 608

10 Basheer U. 9 537000 105 201 250 457 1013

Daily consumption of water in litres

No Head of the 
Family

No. of 
members 

in the 
family

Annual 
Income
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Using Open Office Calc

Data Consolidation

Let us see the preparation of a table as in  fig 3.1 using Open Office
Calc. Open the Open Office Calc Select the cells and type the heading.
In this example the heading  No Name etc, have been typed by taking
two cells each.

To merge two cells perform the following steps:

1. Select A1 and A2.

2. Click on the option Format, select
Merge Cells →  Define (fig 3.2)

3. Cells merge in to a single cell.

4. Type No. in that cell.

5. Similarly merge the cells B1 and
B2.

6. Type Name in the resulting cell.

In the example, the heading ‘No
of members in the family’ is shown in multiple lines within a cell.
When you type this in the merged cells C1,C2 there will be a single
line above the next cells. Let us change it to the given format itself.

1. Select the typical cell and click on the option Cells in Format menu.

2. From the dialog box, click on the
check   box ‘Automatic line break.’
(fig 3.3)

3. Click OK button . Now the single
line in the cell will be changed to
multiple lines.

Daily consumption of water is
written  in five columns. Select the
cells E1 to I1 and click the option
Define in Merge Cells in Format
menu. (Figure 3.2)

Figure 3.2 Format menu

Figure 3.3 Format cell dialog box
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Figure 3.6 Display of the screen when minimising
Auto Pilot Function

Maximize Button

Now you have to type the survey
result in the table. To put the serial no:
use the Fill Series method. Don’t forget
to increase the width of the column
sufficiently while typing the name.
Select al l  columns and give centre
alignment except for the Name.

Addition using Auto Pilot Function

Suppose we have to find  the total quantity of water consumed in
a day by the first family. In the table, select the cell(I3) in the total
column, against the first family and perform the following steps.

• Select the cell I3.

• Click on the Auto Pilot : Function
button at the formula bar.

• Select the option ‘Last Used’ from the
Category list of Auto Pilot Functions
dialog box.(fig 3.4)

• Select the option ‘SUM’ from, the
Functions list box, and click on
‘Next’ (Fig 3.5)

• Minimise the dialog box by clicking
the minimise button near the text-box
Number 1 in the new dialog box(fig :
3.5)

• Select the cells related to the family
whose consumption is to be
calculated (fig : 3.6)

• Click on the maximise button of the
dialog box.

• Click OK button of the completed
dialog box.

Now in the ‘Total’ column of the

Figure 3.5 Function Dialog box

Minimize Button

Figure 3.4 Auto pilot function dialog box

→



6161616161

3. Spread Sheet for Data Consolidation and Analysis3. Spread Sheet for Data Consolidation and Analysis

selected cell, the total consumption of the first family will appear.
Now to find the total for other families, copy this formula to the rest
of the cells, in the Total column. To do this,

• Select the cell (I3) retaining to total of the first family .

• Move the mouse to pointer to the right end corner of the selected cell
to become the shape of ‘+’.

• Now click and drag the mouse downward up to the cell needed (i.e.,
up to I12. )

Have you got the Total usage of water per day by all families?

Finding Individual Consumption Using Formula
Suppose we have to find the per-capita consumption of each family.

This is the average quantity of water used by an individual per day.
How can it be calculated? Divide the  total consumption with the
number of family members.
We can use the formula bar
for this. (Figure 3.7)

Select and merge the cells J1, J2 and type the heading ‘Per-capita
Usage’. Now select the cell (J3) relating to the first family. In that cell.

• Type = from key board.

• Click on the cell Total (I3) against the first family.

• Type division (/) symbol from keyboard.

Formula Bar

Spread Sheet is best suited for complex calculations. It is convenient to use
formula for calculations. Formula Bar is used to enter formula in Spread Sheet. In
Mathematical formula, variables, numbers and operators are used. In the formula
bar by using cell address instead of variables, spread sheet calculates by adopting
the value of cells referred and the result will be the displayed in any cell. For
example let 8305 be the number in cell A1 and 9527 in B1. To get the sum of these
two cells in cell E1 select the cell E1 and in the formula bar give = A1+B1. The
result will be in E1. In this manner the result will be obtained in any cell. We can
use any formula. The formula works only if it starts with the  = symbol.

Figure 3.7 Formula Bar
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• Click on the cell (C3) having No. of members of the first family. In
the selected cell it will be displayed as= I3 / C3.

• Press enter key. It will be displayed the per-capita consumption in
the cell. Copy this formula to other cells in the column (as you did in
the Total Column).

Arrangement of Table : Using ‘Sorting’

Last year you learnt how to arrange the table in ascending or
descending order. Arrange the table based on entries in a column. We

can arrange the table based on name
in alphabetical order. To do this

•  Select the whole table (except No.
and Heading )

• Click on the Sort in Data menu.

• From the dialog box (fig : 3.8)
select column name from the
option Sort by and Ascending
button and Click OK.

Your table will be rearranged in
alphabetical order.

‘Filtering’ to find particular Field

Suppose we have to collect the details of families who are using
certain quantity of water. ‘Filter’ is used for this purpose. For example
we have to collect the details of the families who are using 400 litres of

water per day. The procedure is as
follows:

• Select the entire table ( including
headings)

• select the option Filter from Data
menu and click on Auto Filter (fig:
3.9).

Now a small button with an arrow
mark on it will be displayed on all
heading columns (fig: 3.10).

Figure 3.8 Sort dialog box

Figure 3.9 Selecting Auto Filter from data menu
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If you click on the button of the
Total column, a drop down list will be
displayed. If you click on the option
400, you will get the details of the
families using 400 litres of water.

How do you obtain the detailed
original list? Again click on the button
of the Total column. From the
dropdown option click All.

In the filter list, you have prepared
the details of the families consuming  only 400 litres of water.

Now let us see another case. To get the details of the families who are
using more than 400 litres of water. How  will you do  this? Click on the
button of the Total column and check the list. What are the different
options in it? The list shows all the typical
figures in the column along with the
options - All, Standard, etc. Click on the
option Standard. It will display a dialog
box. (Figure 3.11)

• In the dialog box select Total from the Field name list box.

• Select ‘>’ symbol from Condition list box.

• Click on Value box and type 400 (or click on arrow and select 400)

• Click OK

This will display a table containing the number and details of the
families using above 400 litres of water.

To obtain details of the families consuming who are using water
between 400 and 1000 litres per day, click on the button of the Total
column and from that list click the option Standard.

• In the dialog box select Total from the Field name list box

• Select ‘>’ from Condition list box.

• Type 400 in Value list box.

• Select AND from Operator list box

Figure 3.10 Display of screen after using filter

Figure 3.11 Standard filter dialog box
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• Select Total from second list box
Field name.

• Select ‘<’ symbol from the
Condition of second list box.

• In Value, type 1000 in the second list
box

• Click OK

The new table shows the details of
all  families using water in between
400& 1000 litres per day.

Now to remove the Filter, carry out following steps.

• Select  table.

• Click on Data menu →  Filter  

→

 Remove Filter

• Click on Data menu 

→

 Filter  

→

 Hide auto filter

Conditional statement for Grouping
The per-capita usage of water is related to its availability. It seems

that water is used excessively where it is abundant and used moderately
where there is scarcity. Moreover there can be some relation between
the family income and consumption. Consider that in your place those
who are using more than 80 litres of water per day are excessive users.
Suppose we have to mark ‘Over Users’ in a column against families
whose per-capita consumption is over 80 litres and ‘Under User’ against
families with per capita consumption  less than 80 litres. How will
you do this? First merge the cells K1,K2 and type the heading ‘User
Status’. In that cell, read the per-capita usage and if it is above 80, type
Over User against that family other wise type ‘Under User’ There is
another easy way to do this. Now that will be explained.

We have learnt the BASIC program to print the message ‘PASSED
if the mark > 34, otherwise ‘FAILED’ and the following was the
BASIC statement used then.

IF M>34 THEN PRINT “PASSED” ELSE PRINT “FAILED”

A similar method is used here select the cell (K3) where the message

Figure 3.12 Table after filtering
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is to be displayed. Type =IF (J3>80, ‘‘OVER USER’’, ‘‘UNDER
USER”) and press enter key.

You know why the symbol = is used at the beginning. After the
bracket there are three parts separated with commas. The condition
in the first part, J3> 80 means that the number in the cell J3 is more
than 80.

The second part deals with the message to be displayed in the cell
if the condition included in the first part is true. It is given in
quotations. In this case ‘OVER USER’.

If the condition included in the first part is not true, the
message to be displayed is given as the third part. Include this
also in quotations. Here it is ‘UNDER USER’

Type the above IF statement and press the Enter key, it
will display ‘OVER USER’ in the cell. This is because of the
per-capita usage (number in J3) is more than 80. To copy this formula
to other cells select cell K3 and drag up to K12  Based on the per-capita
usage of each family, these messages ‘OVER USER’ or ‘UNDER
USER’ will be displayed.

Auto Formatting to make Tables Attractive

This method is used to decorate the spread sheet. We can select
the designs from the pre-designed formats. Do the following  steps.

• Select the table

• Click on the  Auto Format from the Format menu.

• Select an Auto Format style from the dialog box.

• Click OK

Our table will be changed according to that design.

You have learnt to draw chart in the spread sheet using the data. It
will be useful if we prepare a line graph showing the relation between
the family income and water consumption for the project. Select the
columns Annual Income and Total from the table prepared in Calc.
Then click on the Chart in the Insert menu. From the dialog box
select the icon column and respond suitably. You will get the bar graph.
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Using Microsoft Excel

Data consolidation

Let us see, how to prepare table in
fig : 3.1 using ‘Microsoft Excel’.

Open Microsoft Excel and select
cells, type the headings in those cells.
Here two cells are joined  together to
form a single cel l  and in that the
headings No. and Name are to be typed.
To do this select A1, A2 together and
click Merge and Centre button in the
tool bar, then the cells will be merged
in to a single cell. In that cell type No.

Now, join the cells B1, B2 into a single cell and type Name in that cell.
In the example the heading ‘No. of . members in the family’ is shown
in multiple lines within a cell. When you type this in the merged cells
C1, C2 there will be only a single line above the next cells. Let us

change this. Select the typical cell and
click the option Cells on the Format
menu. In the option Cells on the
Format menu in the dialog box select
Alignment tab and click on the check
box Wrap Text (fig : 3.14) Click OK
button. Now the single line in the cell
wil l  appear in multiple l ines. Daily
consumption of water in l i tres is
written in five columns. For this select
cells E1 to I1 and click on the button
Merge and Centre in the Tool bar.

Now type the survey result in this
table. Use Fill series to put serial numbers. Don’t forgot to increase
the width of column suitably while typing the Name. Select all columns
and give centre alignment except for Name column.

Figure 3.13 Bar diagram indicating income
and wealth conception
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Figure 3.14 Excel Alignment dialog box
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Addition using Paste Function

In our table suppose we want to find the quantity of water used in
a day by the first family. In the Total column select the cell (I3) related
to the first family and perform the following steps.

• Select the cell I3.

• Click on the Paste Function
button  from the Tool Bar (or
Insert 

→

 Function)

• In the Paste Function dialog box
select Most Recently Used from
the list box Function Category.

• To calculate Total select SUM
from the list box Function name
and click OK. (fig : 3.15)

• The resultant window will hide
some details of the table. If so,
move the window downward.

• Select the cells to find Total usage of the first family (fig: 3.16) click
OK button.

Now the Total column cell will display the total consumption of
the first family.

Copy the formula of this cell to the rest of the cells, to find the
total of other families. To do this:

• Select the cell (I3) relating to the
Total of the first family.

• Move the mouse pointer to the
right end corner of the selected cell
to become the shape of ‘+’.

• Now click it and drag downwards
up to the cell needed (up to I12)

Now you get the total usage of
water per day by all families?

Figure 3.15 Excel paste function dialog box

Figure 3.16 Excel paste function dialog box
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Finding per capita consumption using formula

Suppose we have to find the per-capita consumption of each family.
This is the total quantity of water consumed by an individual per day.
How can it be calculated? Divide the total consumption with the
number of family members.

Select and merge the cells J1, J2 and type heading Per-capita Usage.
Select the cell (J3) against the first family. On that

• Type = from the keyboard

• Click on the cell Total (I3) against the first family.

• Type the division (/) symbol from keyboard.

• Click on the cell (C3) having no. of members of the first family. In
the selected cell it will display = I3/C3.

• Press the Enter key.

• Now copy the formula to the other cells in the column. (As you did
in the Total Column).

Arrangement of Table: Using ‘Sorting’

You have learnt about the arrangement of the table in ascending
or descending order on numbers in a column. Now to arrange the

table in alphabetical order based on
name.

• Select the whole table (Except the
No. and heading.)

• Click on Sort option in the Data
menu.

• From the dialog box (fig 3.17)
select column name from the list
box Sort by.

• Select the option Ascending and
click OK.

Now your table is rearranged in
the alphabetical order.

Figure 3.17 Excel Sort dialog box
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‘Filtering’ To find Particular category

Suppose we have obtain the details of the families from the table
who are using a certain quantity of water. Filtering is used for this
purpose.

For e.g.: We have to obtain the details of the families who are
using 400 litres of water per day. See
the following procedure.

• Select the whole table (including
headings)

• Select the Filter option from the Data
menu.

• Select the Auto Filter option from the
Filter sub menu. (Figure 3.18)

On doing this small buttons with
arrows will appear in the heading of each column of the table. (Figure
3.19)

Now click on the button of the
Total column. A drop down list will
be displayed. If you click on the option
400, you will get the details of the
families using 400 litres of water.

How to obtain the detailed original
list? Again click on the button of the
Total column. From that list click on
the option All.

You have prepared a folder l ist
which contains the details of the family
using only 400 litres of water. Let us
see another problem. Collecting the
details about the families using more
than 400 litres of water. How will you
do this? Click on the button of the
Total column and check the list. Which

Figure 3.20 Custom Auto filter dialog box

Figure 3.18

Figure 3.19 Display of screen while using filter
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are the different options? The list shows all the typed figures in the
column along with the option All, Top 10, Custom, …. Click on the
option Custom. It will display a dialog box. (Figure 3.20)

• In the dialog box select ‘is greater than’ from the first list box.

• Click on the right list box and type 400. (Or click on the arrow and
select 400)

• Click OK button.

It will display the table containing the number and details of the
families litres using more than 400 litres of water.

To obtain the details of the families using water in between 400
and 1000 litres per day. Click on the button of the Total column and
from that list click the option Custom.

• In the dialog box (Fig 3.21). Select ‘is
greater than’ from the first list box.

• Type 400 on the right side list box.

• Select AND.

• Select ‘is less than’ from the second
list box.

• In the second list box type 1000 on
the right side list box.

• Click OK button.

A table will be displayed and it contains the details of all families
using water in between 400 and 1000 litres per day.

To remove the filter in the menu bar click on Data 

→

 Filter 

→

Auto filter.

Conditional Statement for Grouping
The per-capita usage of water is related to its availability. It seems

that water is used excessively where it is abundant and moderately
where there is scarcity. Consider that in your place those who are
using more than 80 litres of water per day are excessive users. Mark in
a column where the per-capita consumption of the families using above
80 litres of water as ‘Over Users’ and those who are using 80 litres or

Figure 3.21 Custom AutoFilter Dialog Box
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below as ‘Under Users’. How are we to do this? First merge
the cells K1, K2 and type the heading ‘User Status’ in that cell.
Go through the per-capita usage and if it is above 80, type ‘Over
User’ against that otherwise type ‘Under User’. There is another
easy way to do this. The procedure is explained below.

We have learnt the BASIC program to print the message
‘PASSED if the mark > 34, otherwise ‘FAILED’ and the following
was the BASIC statement used then.

IF M > 34, THEN PRINT “PASSED” ELSE PRINT “FAILED”

A similar method is used here also. Select the cell (K3) in which
the message is to be displayed and type = IF (J3 > 80, “OVER USER”,
“UNDER USER”) and press Enter key.

You know why the symbol = is used at the beginning. In the
bracket there are three parts separated with commas. The condition
in the first part J3 > 80 means that the number in the cell J3 is more
than 80.

Second part deals with the message to be displayed in the cell, if
the condition in the first part is true. It is placed in quotations. In this
case ‘OVER USER.’

The third part is the message to be displayed if the condition is
not true. Include this also in quotations. In this case it is ‘UNDER
USER.’

Type the above IF statement and press the enter key, it will
displayed OVER USER in the cell. This is because of the per-capita
usage (number in J3) is more than 80. To copy this formula to other
cells, select cell K3 and drag up to K12. Based on the per-capita usage
of each family, it will display the message ‘OVER USER’ or ‘UNDER
USER’ in each cell.

Auto Formatting to make Tables Attractive

This method is used to decorate the spread sheet. We can select
the design from the pre-designed formats. Do the following steps.

• Select the table.
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• Click on Auto Format from
Format menu.

• Select an Auto Format Style
from the dialog box.

• Click OK.

Our table will be
changed according to
that design

You have learnt to draw chart
in the spread sheet using the data.

It will be useful if we prepare a line graph showing the relation between
the family income and water consumption, for our project. Select the
columns Annual Income and Total in the Table. Then click Chart in
the Insert menu. From the dialog box select the icon column and
respond suitably. You will get the bar graph.

More activities for you
1. Type the name of students of your class according to the roll no. Put

the serial number on the left side of the cell where the name is typed,
based on the method you have learnt.

2. Sort the above list based on the name of the students.

3. Type the name of students and marks obtained for different subjects
of your class. Find the total mark. Based on the Total mark, group
the students into different sections. Use conditional statement.

Hints

(a) If the Total mark is above 80% it is Distinction.

(b)If the Total mark is above 60% and below 80% it is First Class.

(c) If the Total mark is above 50% and below 60% it is Second Class.

(d)If the Total mark is above 40% and below 50% it is Third Class.

(e) If the Total mark is below 40% it is Failed.

4. Type the name and age of your family members group them based
on their age (Child, Adult) use conditional statement and filtering.

Figure 3.13 Bar diagram indicating income and
wealth conception
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5. Type the names and the phone numbers of your friend in your class
in the spread sheet. Sort them based on their name and prepare a
telephone directory.

What we have learnt? A self assessment
1. Write the steps to merge two cells.

2. How will you put serial numbers in the cells?

3. How to find total using function (Formula) in spread sheet? List the
different functions.

4. Write the steps to find individual consumption.

5. How to sort data in the spread sheet?

(a) How is sorting in Ascending order performed?

(b)How is sorting in Descending order performed?

6. What is filtering? How can it be done? Write down the steps.

7. Explain conditional statements. Briefly describe their uses.

8. Describe briefly the way to use conditional statements.


